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Installation 

If you’re reading this, congratulations! You’ve just installed the COT Update application. The first time you run the program, 

you’ll be prompted to start your 14-day free trial, or if you have purchased the software, to enter your serial number. 

Please check your email for a receipt containing the serial number. 

You will also need to install the indicators for your version of MetaTrader. Download the installer for the indicators from 

the Downloads page. Run the installer and when prompted, enter the MetaTrader data folder path for each installation of 

MetaTrader on your computer. See the next section below on how to locate your MetaTrader data folder. 

How to Locate the MetaTrader Data Folder 

To locate the data folder for a particular MetaTrader installation, open MetaTrader and select 

Open Data Folder from the File menu. A Windows Explorer window will open. This folder will 

contain the MQL4 folder that contains your expert advisors, indicators and data files.  

You will use this folder path when requested in the indicator installer program. As of version 

2.1, you will no longer need the MetaTrader data folder path to configure COT Update. 

Starting in version 2.1, the COT Update application saves all COT data to the common MetaTrader data folder. To locate the 

common data folder, open MetaEditor (not MetaTrader!) and select Open Common Data Folder from the File menu. 

The COT Update Setup Wizard 

The first time you open the COT Update application, the setup wizard will appear. This will assist you with the essential 

program configuration steps. 

Step 1 

Select the COT Report Format 

 

http://www.cotindicator.com/downloads/
http://www.cotindicator.com/downloads/
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In recent years, the CFTC has introduced the Disaggregated report format, which breaks the commercial & non-commercial 

trader categories down into further categories for commodity futures. The Traders in Financial Futures report does the 

same for financial futures, including currencies and stock indexes. 

If you wish to use the newer Traders in Financial Futures format for currencies, and the Disaggregated format for metals 

and commodities, select Disaggregated in step 1 of the wizard. If you prefer to use the Legacy format (commercial, non-

commercial & non-reportable trader categories), then select Legacy. 

If you’re not sure which report format to use, choose Legacy, as most classic COT trading strategies use the Legacy report 

categories. 

Step 2 

Auto Update 

 

The COT Update application has an auto update feature, which downloads the latest data from the CFTC website each 

weekend and updates the data files in your MetaTrader data folder(s). You can select the weekend day (Saturday or 

Sunday) as well as the update time (which is randomly generated by the wizard). 

Step 3 

Update Data 

When you click the Finish button on the last page of the wizard, the COT Update program will fetch data for all available 

years (from 2000 for the Legacy report, or from mid-2006 for the Disaggregated and Traders in Financial Futures reports) 

and copy the data files to your MetaTrader common data folder. It may take several minutes for this to complete. When 

the update is finished, you will see a confirmation message in the log window. 

COT Update 

The COT Update application downloads the COT data from the CFTC website and copies the data to your MetaTrader 

common data folder. You can also copy the COT data to additional folders, such as the data folder for a non-standard 

MetaTrader install. You can add new instruments and change the report format for each individual instrument. 
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The COT data is separated out by instrument and saved to individual data files. The generated COT data files will be saved 

to the COT folder inside your MetaTrader common data folder. 

Main Window 

If you need to manually update the COT data (for example, after adding or editing instruments), you can do it through the 

COT Update main window. 

 

The Update COT data for: drop-down box allows you to select the time range to update the data for: 

• Current Year - Updates data for the current year, including the most recent week’s data. 

• Previous Year - Updates data for the previous year. You can use this after the start of a new year to update data 

for the previous year. 

• All Years - Updates data for all available years (from 2000 for Legacy reports, or mid-2006 for Disaggregated and 

Traders in Financial Futures reports). All existing data files will be deleted and recreated. 

Press the Update button to begin updating the COT data. If the data file for the current year is out-of-date, the most 

current one will be downloaded from the CFTC website. Previous years will use previously downloaded data. When the 

update is finished, a confirmation message will appear in the log window. 

If you are missing recent data for the current year (for example, after a change in the calendar year, or a delay in issuing 

the COT reports), select the Force update check box to force COT Update to re-download the current year’s data file from 

the CFTC server. You will not normally need to do this. 

If an error occurs, the text will be red. Scroll through the log to locate the source of the error. If you require technical 

assistance, please see the Technical Support topic. 

File Menu 

The File menu contains file-related commands: 

Open Log 

This command opens the log file (displayed in the log window) in your system’s text editor (usually Notepad.) If you need 

to send us a log for troubleshooting, select Open Log to open the log file, and then save the log file to a location of your 

choice. 
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Exit 

Exits the COT Update program. 

Options Menu 

The Options menu contains items for configuring the COT Update program as well as instruments and report formats: 

Instruments 

Opens the Instruments dialog for editing, adding or removing COT instruments. Please see the Instruments Dialog topic 

for more information. 

Settings 

Adjusts the COT Update program settings, including MetaTrader data folders, Auto Update settings, and data file 

download settings. Please see the Settings Dialog topic for more information. 

Help menu 

Documentation and program information: 

Documentation 

Opens this documentation file. 

About 

Lists the current program version and copyright information. 
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Settings Dialog 

The Settings dialog adjusts the COT Update program settings, including the MetaTrader data folders, Auto Update settings, 

and data file download information. To open the Settings dialog, select Settings from the Options menu. 

MetaTrader Data Folders 

Here, you can add or delete MetaTrader data folders. The Common data folder for all MetaTrader installations is included 

by default. If you need to add additional folders -- for non-traditional MetaTrader installations, for example -- you can add 

them here. Please note that you should enter the top-level data folder for your MetaTrader installation (i.e. the folder that 

contains the MQL4 or MQL5 folder). 

For more information on how to locate the MetaTrader data folder for a particular MetaTrader installation, please see the 

How to Locate the MetaTrader Data Folder topic. 

Click the Add button to add a new MetaTrader data folder to the list. If you wish to delete a MetaTrader data folder, select 

it from the list and click the Delete button. 

All of the folders listed in the MetaTrader data folder list will have the COT data files copied to them. If the path contains a 

valid MetaTrader data folder, the data files will be copied to /MQL4/Files/COT or /MQL5/Files/COT , if this is a 

MetaTrader 5 installation. Otherwise, they will be copied to the /COT folder inside the folder root. 

Update 

Here, you can turn the Auto Update feature on or off, and change the update day and time. Note that if you turn Auto 

Update off, you will need to manually update the COT data by opening the COT Update program and clicking the Update 

button. 



7 

COT Report Formats 

This section contains download information for the COT report data on the CFTC website. The COT Download Base URL is 

the URL that contains all of the COT data files on the CFTC server. The table below lists all of the report formats, as well as 

the ZIP file names. 

Unless the file path and names are changed on the CFTC website (which is unlikely), you will not ever need to update 

anything in this section! 

Instruments Dialog 

In the Instruments dialog, you can add, delete or edit the instruments on the COT report that you wish to display on your 

charts. By default, the COT Update program includes the eight most popular currencies, as well as gold and silver. 

• Instrument Name – This is the exact name of the futures instrument as it appears on the COT report. You can 

also enter a partial name – for example the U.S. DOLLAR INDEX instrument leaves off the exchange name, and will 

match any instrument that begins with "U.S. DOLLAR INDEX". 

• Short Name – This is the name of the CSV data file that will be generated. You will also use this name for the 

Instrument Name parameters in the COT indicators for MetaTrader. 

• Report Format – A drop-down list allows you to select the report format. There are six report types, two each for 

the Legacy, Disaggregated and Traders in Financial Futures report formats. Each format has a Futures Only and 

Futures & Options Combined report. 

For more information on the COT report formats, and which one you should choose, please see the COT Report Formats 

topic. 

To edit an instrument, triple-click on the desired field to enable that 

field for editing. (You may need to click an additional time to clear the 

highlighting, or to enable the drop-down box.) Alternately, you can 

press the F2 key while hovering your mouse cursor over the desired 

field. Press the Enter key to finish editing. 

To add a new instrument, click the Add button to open the Add 

Instrument dialog. Enter the Instrument Name from the COT report, a 

Short Name, and select an appropriate Report Format. 

To delete an instrument, select the instrument from the table and click 

the Delete button. 
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Click the OK button in the bottom left of the Instruments dialog to commit your changes, or click Cancel to cancel your 

changes. 

Note: If you add new instruments, or change the report format on existing instruments, remember to update the COT 

data! Select All Years from the drop-down box, then click the Update button in the main window. 

COT Report Formats 

The COT report comes in multiple formats. The Legacy report format is the oldest and the most common. The newer 

Disaggregated formats (including the Traders in Financial Futures or TiFF report) breaks reportable positions down into 

more defined categories. 

Each report format has a Futures Only or Futures-and-Options Combined report. The Futures-and-Options Combined 

report include options data. By default, the COT Indicator Suite uses Futures Only reports, although you can change 

reports formats if you wish. See the previous section on the Instruments Dialog to learn how to change report formats for 

individual instruments. 

The following information from the COT report are displayed on your MetaTrader charts: 

• Long positions – The total long positions for the specified trader classification. 

• Short positions – The total short positions for the specified trader classification. 

• Spreading – These are simultaneous long and short positions held by an individual trader. Spreading positions are 

only reported for certain trader classifications. 

• Net position – The difference between the total long and the total short positions. This number is not displayed 

on the COT report, but the COT indicators use this calculation extensively. Spreading positions are not counted in 

the net position calculation. 

• Open Interest – The total open positions of all types for all traders. 

Legacy 

The Legacy report format is the oldest and the most popular. It contains all reportable futures instruments, including 

commodities, currencies, metals and stock indices. Weekly report data is available as far back as 2000. Many published 

COT trading strategies are based on the Legacy report. 

• Non-Commercial – These are banks, funds and large speculators who generally follow the direction of the 

market. This is the classification most often used by COT report traders. 

• Commercial – These are producers or users of the specified commodity who use the futures market to hedge 

against risk. Commercial positions typically mirror Non-Commercial positions. 

• Non-Reportable – These are traders whose positions are not large enough to be reported in the above two 

categories. This is calculated by subtracting the total reportable positions from the open interest. 

Traders in Financial Futures 

The Traders in Financial Futures (TiFF) report format is a disaggregated report that breaks down non-commercial traders 

into more clearly defined categories. The TiFF report only contains financial futures, including currencies and stock indices. 

For commodities and metals, please see the Disaggregated report below. 
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TiFF data is available as far back as mid-2006. There are few, if any published trading strategies that use the TiFF report, so 

it will be up to the trader to determine how to best trade this report. For more information on the TiFF report, see the TiFF 

Explanatory Notes document from the CFTC. 

• Dealer/Intermediary – These are large banks and dealers in securities and derivatives. 

• Asset Manager/Institutional – These are institutional investors, such as pension and mutual funds. 

• Leveraged Funds – These comprise hedge funds and other large speculators. 

• Other Reportables – Any reportable positions that don’t belong in the above categories. 

• Non-Reportable – The difference between the reportable positions and the open interest. 

Disaggregated 

The Disaggregated report is similar to the TiFF report, except that it contains only commodities. Currencies and stock 

indices are contained on the TiFF report above. The categories on the Disaggregated report break down commercial 

traders into more discrete categories. For more information on the Disaggregated report, see the Disaggregated 

Explanatory Notes from the CFTC. 

• Producer/Merchant/Processor/User – Producers and users of the specified commodity that use the futures 

market to hedge against risk. 

• Swap Dealer – An entity that deals in swaps for a commodity, and uses the futures market to hedge against risk. 

• Managed Money – Large speculators, such as institutional traders and funds. 

• Other Reportable – Reportable positions that do not fall into one of the above categories. 

• Non-Reportable – Calculated by subtracting the total reportable positions from the open interest. 

Which COT Report Format Should I Use? 

If you’re new to trading the COT report, select the Legacy report format. It’s simple, and it follows the market pretty closely. 

Weekly data goes back to 2000, and there are several well-known trading strategies based on this report. 

The newer Disaggregated and TiFF reports break traders down into more discrete categories, which increase market 

transparency. However, not much has been written about how to trade these reports, and the data only goes back to mid-

2006. If you decide to trade the Disaggregated or TiFF reports, be sure to choose the correct report for each instrument. 

Financial futures (including currencies and stock indices) are on the TiFF report, while commodities and metals are on the 

Disaggregated report. 

COT Indicators 

There are five indicators that come with the COT Indicator Suite. These appear 

inside the COT folder in the Navigator window inside MetaTrader. The Legacy 

indicators are in the root of the COT folder. The Disaggregated and TiFF 

indicators are in their respective subfolders. Select the indicator for the correct 

report format for the instrument that you wish to chart. 

http://www.cftc.gov/ucm/groups/public/@commitmentsoftraders/documents/file/tfmexplanatorynotes.pdf
http://www.cftc.gov/ucm/groups/public/@commitmentsoftraders/documents/file/tfmexplanatorynotes.pdf
http://www.cftc.gov/MarketReports/CommitmentsofTraders/DisaggregatedExplanatoryNotes/index.htm
http://www.cftc.gov/MarketReports/CommitmentsofTraders/DisaggregatedExplanatoryNotes/index.htm
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If you’re not sure which report format to use, open COT Update and check the Instruments dialog to see which report type 

is being used for that instrument. Alternately, you can also open your MetaTrader data folder and check the Files/COT 

subfolders to locate the data file. 

COT Indicator Parameters 

Each of the COT Indicators has one or more instrument name parameters (for example, Instrument Short Name). Here, you 

will enter the short name of the instrument, as indicated in the Instruments dialog in COT Update. (By default, all currencies 

use the three-letter abbreviation used in Forex pairs – for example, EUR for Euro, or USD for the US Dollar.) 

Most of the indicators also have a Classification parameter that can be selected via a drop-down box. This is the report 

category that you wish to graph. Please see the previous section on COT Report Formats for more information on the 

trader classifications. 

A few of the indicators also have an Invert Display parameter. This will invert the indicator line(s) to match the price 

movement of the currency pair or instrument on the chart, if necessary. 

COT Totals 

The COT Totals indicator displays the total long, short and spreading positions for the specified trader classification. 

(Spreading is only displayed for certain categories). The long positions are displayed in green above the zero axis, while 

the short positions are displayed in red (in negative numbers) below the zero axis. The spreading positions are in orange, 

overlaid above the zero axis. A yellow line displays the net long/short position. 

• Instrument Short Name – The short name of the instrument to graph, for example, USD. 

• Classification – A drop-down box to select the report category to graph. 
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COT Graph 

The COT Graph indicator displays the net long/short position for multiple trader classifications for the specified 

instrument. The trader classifications and the line colors depend on the report format. The example above plots the net 

Commercial and Non-Commercial positions on the Legacy report. You can also invert the display so that the indicator will 

track the price movement of the currency pair or instrument on the chart. 

• Instrument Short Name – The short name of the instrument to graph, for example, USD. 

• Show…Positions – Turn graphing for individual trader classifications on and off. The classifications depend on the 

report format that you are displaying. 

• Invert Display – Invert the lines of the indicator. 

COT Open Interest 

 

The COT Open Interest indicator simply displays the open interest for the specified instrument. 

• Instrument Short Name – The short name of the instrument to graph, for example, USD. 
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COT Index 

 

The COT Index indicator is based on the formula popularized by Larry Williams and Steve Briese in their books. The COT 

Index calculates the net long/short position for a specified trader classification (typically non-commercial or speculative 

traders), and locates the minimum and maximum value for a specified number of weeks. The line is graphed on a 0 to 100 

scale. 

If the COT Index is close to 100, that indicates that the net long position is near or at a historic high. The reverse is true if 

the COT Index is close to 0. This can be used to locate overbought or oversold areas. 

• Instrument Short Name – The short name of the instrument to graph, for example, USD. 

• Number of Weeks – The number of weeks to use for calculating the indicator. The default is to calculate the 

minimum and maximum for the last three years. 

• Classification – A drop-down box to select the report category to graph. 

• Invert Display – Invert the lines of the indicator. 

COT Pair Index 

The COT Pair Index indicator is exclusive to the COT Indicator Suite. It combines the net positions for two different currency 

instruments and graphs them in such a way as to accurately reflect the movement of a currency pair. The line is graphed 

on a 0 to 100 scale, representing the relative strength of one currency against another. 

To use the COT Pair index, you must specify two instruments, a long and a short instrument. The long instrument is the 

first instrument in the currency pair name, while the short instrument is the second. For example, for EURUSD, the EUR is 

the long instrument, while the USD is the short instrument. 

The COT Pair Index is not available for Disaggregated reports. 
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• Long Instrument – The currency that represent a long movement on a currency pair. 

• Short Instrument – The currency that represents a short movement on a currency pair. 

• Classification – A drop-down box to select the report category to graph. 

• Invert Display – Invert the lines of the indicator. 

Technical Support 

Email: support@cotindicator.com 

If you are having an issue with the COT Update program, be sure to include the update log along with your email. Select 

Open Log from the File menu, save the log file to your hard drive, and attach it to your message. 

"COT Error: Invalid report format" error message 

If you get a "COT Error: Invalid report format" alert message when loading a COT indicator into MetaTrader, the most likely 

cause is that the report format doesn't match the indicator format. 

For example, if you're using the COT Totals (TiFF) indicator for USD (U.S. DOLLAR INDEX), but you have the report format 

for U.S. DOLLAR INDEX set to Legacy in the COT Update Instruments dialog, then the relevant report columns will not exist 

in the data file. Select the correct indicator (in this case, COT Totals in the COT/Legacy indicator folder), or change the 

report format in COT Update, then re-run the update to fetch the correct data format. 

mailto:support@cotindicator.com

